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	Preparing Presentations 
for Delivery


Overview

Chapter 7 focuses on the preparation of a presentation for delivery in person.  The chapter covers such topics as rehearsing a presentation and setting up a show, embedding fonts, optimizing pictures, creating a Photo Album, and using the Package for CD option for displaying your presentation on another computer. It also covers printing supplements (handouts and speaker’s notes).  Additionally, methods of presenting with presentation equipment are discussed including how to use PowerPoint’s various pen and pointer tools.
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Pre Test/ Post Test—Chapter 7
Fill in the Blanks

1. When setting slide timings by rehearsing them as you go, click the _______ button to display the next slide.
2. The _______ _______ _______ dialog box provides several options and check boxes for customizing a slide show.
3. A presentations that automatically advances slides, such as for a trade show or kiosk, typically runs in a _________ _________.

4. The __________ __________ option helps reduce a presentation’s file size by reducing image resolution or deleting cropped areas of pictures.
5. PowerPoint’s ________ ________ feature will quickly prepare a slide show to display a collection of photographs.
6. In PowerPoint, an ________ ________ is a printout of the slides in your presentation.
7. When preparing for a presentation, create ________ ________ to record additional information you may need when delivering the presentation.
8. The _____ _____ drop-down list in the Print dialog window allows you to select how a presentation is printed.

9. When printing handouts, you can choose to order the slides on a page in a ________ or ________ fashion.

10. Movements of your ________ ________ to call attention to something on your slide during a slide show should be deliberate.


Multiple Choice

11. How many minutes are typically required to explain slide contents?
A. 1
B. 1.5
C. 2
D. 2.5
E. more than 2.5
12. Which toolbar is displayed when you choose the Rehearse Timings menu item from the Slide Show menu?
A. Slide Show toolbar
B. Timings toolbar
C. Presentation toolbar
D. Rehearsal toolbar
13. To manually reset the Slide Time clock to zero seconds, click which button on the toolbar mentioned in question 12?
A. Reset
B. Repeat
C. Zero
D. Clock Reset
14. Which PowerPoint feature saves a presentation file with embedded fonts and linked files for display on another computer?
A. Pack Wizard
B. Go Wizard
C. Package for CD
D. none of the above
15. Using the feature mentioned in question 14, which additional option can be included so a presentation can be viewed on a computer that does not have PowerPoint installed on it?
A. PowerPoint Viewer
B. PowerPoint Showcase
C. PowerPoint Enabler
D. PowerPoint Presenter
16. When printing handouts, you can include how many slides on a page?
A. two
B. three
C. four
D. six
E. all of the above
17. To enlarge the Notes pane for easier typing, you can:
A. drag the Note pane’s top border
B. double-click on the Notes pane’s top border
C. right-click on the Note pane’s top border and choose the Enlarge menu item
D. none of the above
18. Which is not a speaking tip for presenting with projection equipment?

A. test sound volume levels
B. be sure your slide show loads properly
C. arrange your notes in a folder so you are not handling loose pages
D. look continually at the projected image on the large screen
E. use the computer monitor as a guide

19. The Arrow pointer cannot be changed to what? 
A. Felt tip pen
B. Highlighter
C. Laser light 
D. Ball point pen 
20. To blank a slide during a slide show press:
A. Backspace
B. B key
C. X key
D. Ctrl + B
True / False
21. ___Slide timings cannot be set manually by a user.
22. ___TrueType fonts can be embedded in presentations that will be displayed on other computers.
23. ___When creating a Photo Album, photographs can only be inserted from a scanner or camera.
24. ___You should distribute reference handouts during the presentation.
25. ___The Handout option has a master view where you can control the way headers and footers print on a page.
26. ___PowerPoint’s Notes pages can be used to store reminders, relevant facts, and anecdotes to be printed as speaker notes.
27. ___Presentation slides can be printed as overhead transparencies.
28. ___A speaker should decide in advance how questions will be handled.

29. ___By default, PowerPoint always begins a slide show on the first slide of a presentation.
30. ___During a presentation you can use writing tools on a slide to highlight or emphasize important information.
Teaching Tips and Lecture Notes
Often you can’t count on the computer where you will give your presentation to have all of the fonts you need or if PowerPoint is available, it may be an older version. If you have linked files in your presentation, links to those files can be broken when you change to a different computer.  This happens frequently in business, and students can encounter this situation, too, when they give presentations in a variety of classrooms.  Therefore, the Package for CD option is invaluable because you can save your presentation with its fonts embedded and all related files linked. This topic is very important for students to understand. 
The chapter also covers how to prepare presentation supplements to help with your delivery and to provide helpful handout pages so your audience can take notes during a presentation. Students will be introduced to ways to optimize their files, too, and are reminded about the need to keep their files organized. Then the final module addresses some of the speaking tips for presenting successfully with PowerPoint and projection equipment. There is a lot to think about when you are using equipment to support your message, and it takes practice to use it skillfully.

Section 7.1 Preparing and Packaging Presentations
This section covers advanced features generally used in preparation for presenting your presentations.  Opening comments explain the importance of rehearsing and suggest how you can use PowerPoint’s Rehearse Timings feature to practice delivery. Section 7.1.1 covers the application of timings to presentation slides, using the Set Up Show dialog window (to configure the presentation, especially for stand-alone presentation execution), and using the Package for CD to show the presentation on another computer (even if it doesn’t have PowerPoint installed on it).

Section 7.1.1 Rehearsing a Presentation Using Timings
Concept:
Adding timings to a presentation

Method:
Timings can be added to each slide to control how long each slide is displayed during a presentation.  Once a slide’s time has expired (during the presentation) the next slide will be displayed.  To set the timings for each slide, you can choose one of the two methods below.

· Set the slide timings by rehearsing the presentation—From the Slide Show menu, choose Rehearse Timings.  Then, for each slide, click the Advance button on the Rehearsal toolbar when an appropriate amount of time has passed and the next slide should be shown.  The time interval between button clicks is recorded for each slide and becomes the slide’s timing value.

· Set the slide timings manually— From the Slide Show menu, choose Slide Transition. Select one or more slides from the Outline or Slides tabs (or in Slide Show view).  Then in the Slide Transition task pane, select the Automatically after: check box and use the spin control to specify how many seconds each selected slide is displayed. 

Now, whenever the presentation is displayed, the slide timings will control the amount of time each slide is displayed.  With this feature, the presentation speaker need not control the presentation with the mouse.

Notes:
Slide timings can certainly be used for rehearsal, but they can also be used for self-running presentations such as for a trade show or an open house event. 
Section 7.1.2 Using the Set Up Show Dialog Box

Concept:
Using the Set Up Show dialog box to configure a presentation

Method:
The Set Up Show dialog box can be used to configure a PowerPoint presentation.  To display the box, choose the Slide Show menu then Set Up Show.
In the Set Up Show dialog box that appears, you can set controls for how the presentation is displayed--full screen when presented by a speaker or browsed at a kiosk and window when browsed by an individual. You can control whether you show all slides or a particular range of slides. Other settings control if the presentation loops when it ends, includes narration or animation, whether or not the presentation adheres to timing values for the slides or is controlled manually by a mouse or keyboard click. Also, you can control the pen tool color or whether multiple monitors are used, and the resolution at which to display the presentation.

When the selections have been made, click the OK button.  The configuration will be used when the presentation is next displayed.

Notes:
None.

Section 7.1.3 Embedding Fonts
Concept: 
Embedding fonts for situations when the needed fonts might not be available on the computer used to display a presentation
Method:
From the File menu, select Save As, then choose the Tools button, Save Options. Then on the Save Options dialog box, select Embed TrueType fonts. You have two options for whether or not you want to embed all characters or only the one you use.
Notes:
Embedding fonts does increase a presentation’s file size, but it can give you “peace of mind” when you know you will be using a different computer when you present from the one used to develop your slide show.
Section 7.1.4 Optimizing Pictures

Concept: 
Compressing pictures to reduce a presentation’s file size
Method:
With a picture image selected, on the Picture toolbar choose the Compress Pictures button. You can choose to apply compression to only the selected picture or all pictures in the document. The resolution for print is the highest one available at 200 dpi (dots per inch); if you change to Web/Screen, the resolution changes to 96 dpi. Very little, if any, difference will be noticeable with this change to the images you see on screen. A difference may be noticeable, however, for slides that you print. Deleting the areas of pictures that have been cropped will also cause a reduction in file size.
Notes:
With this method, a tenfold or more reduction in slide show file size can occur depending on the format of the pictures. Remember that this change is happening only on the presentation file. If you have the original picture images stored on the same disk or folder on your hard drive, those images will not be affected.  When you insert an image into PowerPoint, you are essentially copying and pasting; so compression affects the copied version but not the original.
Section 7.1.5 Creating a Photo Album Presentation

Concept: 
Creating a Photo Album to display a series of pictures
Method:
Choose Insert, Picture, New Photo Album to quickly insert a series of photographs into a slide show on separate slides. The Photo Album dialog box provides options for rearranging the picture sequence and even using buttons to adjust the brightness, contrast, and rotation of the images. Pictures can be expanded to fill the entire slide, or different layouts used so the shapes can be framed in different ways. Even design templates can be applied.
Notes:
This is a very quick technique that achieves impressive results. When pictures have been inserted with this technique, they can be repositioned or modified just as though they were inserted individually on each different slide.
Section 7.1.6 Using the Package for CD Option

Concept:
Using Package for CD to display a presentation on another computer
Method:
The Package for CD can be used to transport a PowerPoint presentation (with its fonts and linked files) to another computer for presentations.  You can also include, if desired, the PowerPoint viewer, so that if the destination computer does not have PowerPoint installed, the presentation can still be viewed.

To use this feature, choose File, Package for CD.  The Package for CD dialog box allows you to name the CD and add the presentation file.  You can choose to copy to a CD or to a Folder instead. Click the Options button and then make additional selections from the Options dialog box. Add checks to include the PowerPoint viewer (to play the presentation without PowerPoint), include Linked files, and to include embedded TrueType fonts. You can even add a password that would then become necessary to open the file. 
Notes:
Remind students that this feature is especially important to use when they have used linked files.
Section 7.1.7 Saving to a Previous Version of PowerPoint

Concept:
Saving to a previous version of PowerPoint
Method:
Choose File, Save As. In the Save As dialog box, click the down arrow for Save as type then select PowerPoint 97-2003 & 95 Presentation. This feature will be helpful to students if they have started a presentation in a computer lab and need to finish the presentation with an older version of PowerPoint. 
Notes:
The author has found most features are downwardly compatible even without using this technique, but it can be used as a safety precaution. A presentation’s file size will be increased and any animation movements that are not possible with the earlier version of the software will be lost.

Section 7.2 Preparing Supplements for Printing

Printing presentation slides was introduced in Lesson 1.4.4 and students have probably printed slides or handouts as exercises have been completed throughout this text. So Section 7.2 provides information on how to prepare and use effectively both audience handouts and speaker notes.  Handouts can be printed with 1, 2, 3, 4, 6, or 9 miniature slides on each page using either portrait or landscape page orientation.  Outlines can be printed to examine text content and could be used as a handout.  Speaker’s notes print a slide at the top of a page and any notes entered in the Notes pane printed below the slide. Handouts, speaker’s notes pages, and outlines can include header and footer information. On a handout, for example, you might want to include a presenter’s name and company identification on each page of the printed material.

Be sure to discuss with students the advantages and disadvantages of handout distribution before, during, or after a presentation.

Section 7.2.1 Printing Audience Handouts
Concept:
Printing slide handouts for your audience

Method:
To print slide handouts for your audience, choose the Print menu item from the File menu.  Then, in the Print what drop-down list, select the Handouts item.  Next, in the Handouts area (to the right of the drop-down list), use the Slides per page drop-down list to indicate the number of slides to print per handout page and select either the Horizontal or Vertical ordering for how slides are positioned on the page.  The Scale to fit paper option will make the slides slightly larger; the Frame slides option places a single border line around each slide which can give them better definition on the page.  Click the Preview button to see how the slides will look before printing. Finally, press the OK button to send the handouts to the selected printer.

Notes:
On the Preview toolbar, you can click the Landscape button if this orientation will be more suitable for the number of slides you are using. For example, if you have four slides, printing them in landscape orientation would make each slide larger than if you print the page set for six slides on a page in portrait orientation.
It is always a good idea to preview your presentation handouts before printing. Not all color schemes translate well if you are printing in black and white. You might need to make some color adjustments and prepare a second copy of your presentation with colors that generate an easy-to-read handout using grayscale (will show black and shades of gray). 

Also, think about the total number of pages you are creating with your slides. You might need to omit some slides that may not be essential on your handout so your presentation would fit on the front and back of one page for photocopying. While it is possible to put nine slides on a page, the slide content is really not readable in the small slide size that is created. So usually place no more than six slides on a page.

Section 7.2.2 Printing Outlines

Concept:
Printing an outline
Method:
To print an outline, choose File, Print. Select Outline View in the Print what drop-down list, preview, then click OK button to print.
Notes:
If your presentation consists of bulleted lists, then you might like to use an outline to review before your presentation or for notes while talking. While not as attractive as miniature slides printed on a page, an outline could be used as a handout because it would provide blank space for an individual to add his or her handwritten notes during a presentation.

Section 7.2.3 Printing Speaker Notes

Concept:
Printing as Notes pages the speaker notes that are typed in the Notes pane
Method:
To add speaker notes to a slide, click in the Notes area, just below the slide in Normal view.  Notes typed in this area are saved with each slide and can be printed as hard copy reminders for use during a presentation.

To print the notes pages, choose the Print menu item from the File menu and select Notes Pages from the Print what drop-down list.  Then, press the OK button to send the notes pages to the selected printer.

Notes:
The slide content will determine how many speaker notes are needed. You might need additional information you want to explain or a quote printed out so you remember the exact wording. But, especially if a monitor is positioned so you can see it while talking, you should not need notes for every slide. Plan carefully to prepare what you need and no more.  Too much page turning can be distracting for an audience and can be a temptation for a speaker to read. 
Section 7.2.4 Printing Slides for Overhead Transparencies
Concept:
Printing slides for overhead transparencies 

Method:
To make overhead transparencies, print full-size slides by choosing File, Page Setup. Select Overhead in the Slides sized for box and click the command button.
Notes:
Overhead transparencies remain a very convenient presentation product for situations where computer equipment is not available. Be sure you use the appropriate type of transparency for the type of printer that you have. Design concepts for slide show also apply to overhead transparencies.
7.3 Delivering a Successful Presentation

Successful presentations require a lot of thoughtful preparation, a clear message, and an effective delivery. No one part is enough. And knowing only how to use PowerPoint is not enough. Practice with the desire to work toward improvement is important. 

Review general speaking tips and tips for using PowerPoint with projection equipment. Schedule practice sessions where students can become familiar with using equipment before they are evaluated on their presentation delivery.

After their presentations, help students to reflect on what they did and identify their strengths and weaknesses. Identifying something that should be improved is the first step toward improvement. Unless this happens, students will continue to use the same ineffective techniques over and over with every presentation they make.

One good instructional technique for helping students assess their performance is to video tape their presentations.  Then they can review their own tapes and look for mannerisms that might be distracting or ineffective. Often this activity can be a confidence builder, too, because students may realize that they look better while talking than they thought they would. As part of their self analysis, you might ask students to write a reflection report about their experiences in preparing for their presentation, delivery techniques they used effectively and ineffectively, and what they need to work on for improvement in the future.
Peer evaluations can be helpful, too, especially as a means to compliment each other on effective strategies and design techniques used. 

Section 7.3.1 Starting and Moving Within Your Slide Show

Concept: 
Starting your slide show
Method:
A slide show will begin on the current slide unless you use the Set Up Show dialog box to indicate a particular range of slides to display. Select the slide you first want to display and click on the Slide Show button in the View buttons area. You can also select Slide Show, View Show or use the keyboard and simply press F5 to start your slide show.
Notes:
As indicated in the text, you can prepare a black slide to be displayed before your title slide to make its appearance dramatic when you are ready to display it, or you can begin your presentation with a title slide displayed.
Concept: 
Moving within your slide show (also called navigating)
Method:
A left mouse click and several keyboard characters (space bar, backspace, Enter, Page Up, Page Down, up arrow, down arrow) will move forward and backward through your slides. Pressing Esc will end a slide show. The right-click menu enables you to choose Previous, Next, or to Go To a particular slide. You can also end a slide show using the right-click menu.
Another way to move through slides is to use the Arrow options that appear on the lower left of each slide as long as this feature is enabled. You can click the forward and back arrows or the slide icon to choose from options so you can go to a particular slide.
Notes:
A remote control can be purchased for your computer, too, so you can still advance through your slides while moving about the presentation room instead of being positioned near the computer.
Section 7.3.2 Using Arrow Pointer, Pen Tools, and Highlighter

Concept: 
Using the Arrow Pointer by moving your mouse
Method:
Instead of using your hand to point to items on the projection screen while you are talking, use your mouse to move its pointer across the screen.
Notes:
Be careful with this technique and avoid nervous mannerisms that will cause your pointer to flip around on the screen. In fact, be very deliberate when you make mouse movements that you want your audience to follow and give your audience time to find the object to which you are pointing.
Concept: 
Using the Pen Tools to annotate
Method:
The Pen Tools can be activated two ways: press Ctrl + P or right-click and choose Pointer Options. You can select from a BallPoint Pen or Felt Tip Pen (produces a thicker line) for drawing.  The ink colors can be changed and the marks you make can be removed using the Eraser option. 
Notes:
When your slide show is complete, you will be given the option to keep your ink annotations. This could be very helpful if you have been brainstorming and captured some important ideas during a meeting or a diagram sketch that you want to keep.
Concept: 
Using the Highlighter to call attention
Method:
The Highlighter works just like a highlight pen to mark on top of slide content with wide marks. You access this feature through the right-click menu. 
Notes:
If you want your audience to be able to see the content through the highlight marks, then be sure you select a light color for your ink.
Section 7.3.3 Hiding and Blanking Slides

Concept: 
Hiding slides during a slide show
Method:
This feature requires an advance setting that you control in Slide Sorter View. Select the slide (or slides) you want to hide and then click the Hide Slide button on the Slide Sorter toolbar. These slides will not display during your slideshow unless you type the number of the slide and press Enter or use the right-click menu and use the Go To slide option.
Notes:
This PowerPoint feature would enable you to have additional information to support your presentation that you could access only if needed.
Concept: 
Blanking slides during a slide show
Method:
Perhaps during a presentation you want to spontaneously interject a different idea, or stop your slideshow to have a discussion without a particular slide being displayed. Simply press the B key to blank your screen to black then press the B key again to resume your slide show. Or you could press the W key to blank your screen to white then press the W key again to resume your slide show.
Notes:
This is an excellent feature to use instead of turning off a projector in the middle of your presentation and can be used effectively to draw the attention of your audience back to you.
Pre Test/Post Test Answers

	
	Fill in the Blanks
	Multiple Choice
	True/False

	
	1. Advance (7.1.1:PP 313)
2. Set Up Show (7.1.2:PP 315)
3. continuous loop (7.1.2:PP 315)
4. Compress Pictures (7.1.4:PP 319)
5. Photo Album ( 7.1.5:PP 320) 
6. audience handout (7.2:PP 327)
7. speaker notes (7.2:PP 327)
8. Print what (7.2.1:PP 327)
9. horizontal/vertical (7.2.1:PP 327)
10. Arrow Pointer (7.3.2:PP 339)

	11. C (7.1:PP 312)
12. D (7.1.1:PP 314)
13. B (7.1.1:PP 314)
14. C (7.1.6:PP 323)
15. A (7.1.6:PP 323)
16. E (7.2:PP 326)
17. A (7.2.3:PP 332)
18. D (7.3:PP 336)
19. C (7.3.2:PP 339)
20. B (7.3.3:PP 341)

	21. F (7.1.1:PP 313)

22. T (7.1.3:PP 316)

23. F (7.1.5:PP 321)

24. F (7.2:PP 327)

25. T (7.2.1:PP 328)

26. T (7.2.3:PP 332)

27. T (7.2.3:PP 334)

28. T (7.3:PP 336)
29. F (7.3.1:PP 337)

30. T (7.3.2:PP 339)



Self Check Question Answers
1. To rehearse timings in PowerPoint, the software uses a clock to record the actual time you spend on each slide as you go through your slide show in rehearsal mode. This feature is very helpful for practicing presentation delivery and timings can be saved in you need to prepare the slide show for viewing as a kiosk-type presentation that is self-running.
2. The Set Up Show dialog box enables you to control several options for a presentation slide show such as show type, the number of slides to show, how slides are advanced, looping, and whether or not to include narration or animation.
3. Fonts should be embedded in a presentation when they are not likely to be available on the computer used to display the presentation.

4. If you are setting up a kiosk-style presentation, a self-running presentation, choosing the continuous loop option will cause the presentation to automatically move from the last slide to the first slide to repeat the presentation?

5. If you compress a picture a picture and the results is unsatisfactory, click the Reset Picture button to restore the picture to its original quality.

6. When you have linked files, the Package for CD option is especially helpful because this method of saving your presentation copies the slide show file plus all linked files. If you need to display using a computer without PowerPoint, then a viewer can be included at the time you create the CD. 

7. A collection of pictures can be quickly arranged for display Photo Album feature accessible through the Insert menu. A variety of layouts, frame shapes, and picture options are available. Design templates can be applied just as in any other presentation.

8. When notes have been typed for slides, they can be printed by selecting the Notes Pages option on the Print dialog box. The slide will print at the top of the page and the typed notes will print at the bottom.

9. When you have the opportunity to position your equipment for projecting with a computer, arrange the monitor so you can see it while you are talking and arrange the keyboard and mouse for easy access. Be sure to control computer cables and electrical cords for safety.

10. The left mouse button, keyboard, or page down/page up keys can be used to advance sequentially through a presentation slide show. To move to a particular slide, right-click then select Go to Slide to choose the slide number you want to display.

	True/False 
	Multiple Choice

	1. T

2. F

3. T

4. T

5. F

6. T

7. F

8. F

9. F

10. T
	1. D

2. C

3. B

4. A 

5. C

6. B

7. A

8. D

9. C

10. D



Additional Exercises

Activity 1

Prepare a slide show to promote a special seasonal or holiday event for your school, church, or business as a self-running informational slide show that would be available for viewing on a computer placed in a high-traffic area. Use the storyboard technique to sketch slide content for six to eight slides. Create an originally designed template for your topic. Search for appropriate pictures and insert as many realistic photo images as you can find instead of clip art images. Use the Compress Pictures dialog box to change the picture resolution for an on-screen show. Use the Rehearse Timings feature to set up transitions with appropriate movements and timings. Set up the show to loop continuously.
Activity 2

Prepare a Photo Album as a gift for a friend or relative. Scan a series of pictures, or use digital pictures, for a special event or to celebrate a birthday. Apply interesting layout and framing techniques and add an appropriate template. Customize the template to blend with the theme of the Photo Album. Set up automatic transitions and add a music clip that plays as all the slides are displayed. Use the Compress Pictures dialog box to change the picture resolution for an on-screen slide show. Use the Package for CD option to be sure that the music file is appropriately linked and include the PowerPoint viewer so the slide show can be viewed without PowerPoint. 
Activity 3

Prepare a presentation about presentation delivery. In addition to the material in module 7.3, review three or more articles from www.presentersuniversity.com sponsored by InFocus, a presentation equipment manufacturer. Learn how to navigate through the site (which also has many free PowerPoint templates that you can download. In the Courses section, excellent articles are provided on content, delivery, and visual aids. Many presentation consultants and companies contribute to the content of this site.
Develop your slides (no more than 12) and use the Notes pane to add additional thoughts you would want to cover for part of the slides. Use the Rehearse timings feature to practice your content delivery and save slide timings so you can go through the presentation more than one time. Print speaker notes and audience handouts with six slides on a page.

During class, divide into small groups and give your presentation. Distribute the handout to other members of your group so they can take notes. When all presentations are complete, use the handouts to discuss the illustration techniques used or other techniques that would improve the designs.
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